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Conventions
The typographic conventions used in this help are described below.
Convention Description
Bold Used to denote components of the user interface such as

buttons, field names, menus, and menu options.
For example, the New button.

Menu...MenuOption Select the menu from the menu bar then select the menu option
from the menu.

For example, File...Open would mean to select the File menu
and then the Open option.

CAPS Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Italics Used to denote emphasis, captions and the result of an action in
a procedure.

Contact Us
General enquiries on the qHolo for DigitalMicropraph should be sent to:

HREM Research Inc.
14-48 Matsukazedai
Higashimatsuyama
Saitama 355-0055

Japan
email: support@hremresearch.com
Website: www. hremresearch.com

Enquiries on gHolo of a technical nature should be directed to:

Dr. Christophe Gatel
CEMES-CNRS, Toulouse, France
email: christophe.gatel@cemes.fr
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and criminal penalties.
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Introduction to gHolo

Welcome to the gHolo plug-in for DigitalMicrograph (Gatan Inc.). The software provides all
the tools you need to carry out the quantitative analysis of off-axis electron holograms, or any
other interference patterns for that matter. In particular, the software was designed for the
analysis of magnetic and electric fields. This area of electron holography is known as “medium
resolution” as opposed to high-resolution electron holography that aims to image atomic
structure.

The software is designed for off-line analysis, for quantitative analysis and the highest precision.
For at-the-microscope help with holography, please use the HoloLive! module dedicated to live
reconstruction of the hologram phase during experiments.

Here are the main features of gHolo:

Phase reconstruction using the Fourier transform method
Automatic side-band detection

Carrier frequency refinement via user-defined reference area
Distortion correction via a reference hologram

Phase unwrapping

Phase gradients

Quantification of magnetic and electric fields

Vector field visualisation tools

qHolo has been developed over a number of years and the original scripts have already been
used in several publications:

[1] C. Gatel, B. Warot-Fonrose, N. Bizi¢re, L. A. Rodriguez, D. Reyes, R. Cours, M.
Castiella, M.-J. Casanove, Nature Communications 8, 15703 (2017). Inhomogeneous

spatial distribution of the magnetic transition in an iron-rhodium thin film.
10.1038/ncomms15703

[2] C. Gatel, X. Fu, V. Serin, M. Eddrief, V. Etgens, B. Warot-Fonrose, Nano Letters 17,
2460—2466 (2017). In Depth Spatially Inhomogeneous Phase Transition in Epitaxial
MnAs Film on GaAs(001). 10.1021/acs.nanolett. 7600144

[3] C. Gatel, J. Dupuy, F. Houdellier, M.J. Hytch, Appl. Phys. Lett. 113, 133102 (2018).
Unlimited acquisition time in electron holography by automated feedback control of
transmission electron microscope. 10.1063/1.5050906

[4] M. Brodovoi, K. Gruel, A. Masseboeuf, L. Chapuis, M. Hytch, F. Lorut, and C. Gatel,
Appl. Phys. Lett. 120, 233501 (2022). Mapping electric fields in real nanodevices by
operando electron holography. 10.1063/5.0092019, hal-03752638

[5] C. Gatel, R. Serra, K. Gruel, A. Masseboeuf, L. Chapuis, R. Cours, L. Zhang, B. Warot-
Fonrose, and M. J. Hytch, Phys. Rev. Lett. 129, 137701 (2022). Extended charge

layers in metal-oxide-semiconductor nanocapacitors revealed by operando electron
holography. 10.1103/PhysRevLett.129.137701, hal-03787333

[6] L.Zhang, F. Lorut, K. Gruel, M.J. Hytch, and C. Gatel, Nano Letters 24, 5913-5919
(2024). Measuring electrical resistivity at the nanoscale in phase-change materials.
10.1021/acs.nanolett.4c01462
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This manual is more of a tutorial: we will go through the main functions of gHolo step by step
with a prepared example. For details of all the commands you can use the Quick Reference

Guide.

Glossary of abbreviations and technical terms

DM Digital Micrograph (Gatan Inc.)
q Carrier frequency vector
ROI Region of interest
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But before starting, there are a few important points to remember:

1. gHolo is a plug-in for DigitalMicrograph (Gatan Inc.). This means that results are
fully compatible with the other functions present in DM. For example, profiles drawn
across the live phase images using the DM line profile tool will be automatically
updated. Similarly, any calibration of the images within DM will be transferred to the
phase images.

2. The complete list of commands related to qHolo are located in the menu:
qHolo | Custom Help
Power Spectrum
Phase Calculation
Define Reference 4

Repeat Phase

Unwrap/Wrap Phase

Align Two Phase Images...

Cosine >
Contours 4
Phase Adjustment 2
Phase Maths 4
Vectorial 4
qHolo Tools »
Restore Factory Settings
Display qHolo Window

3. However, it is more fun to access command using the gHolo Control window below.
You have direct access via the Technique Manager (DM Window>Floating
windows>Technique Manager).

qHolo

; - Tools
Extraction Operations Technical note: For GMS 2.x, the

window can be opened from the last

menu item of the gHolo menu:
Vectorial Display qHolo Window.

In the following, we will assume use of the qHolo control window but everything can be
accessed via qHolo menu, along with all the others.
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A summary of the features can be seen below:

Unwrap Phase

Define Reference — Cosine

Extract Area
Power Spectrum
W ( Live Contrast
v ¢ v

Extraction Operations Tools

& ©

Vectorial

O

j T L Colour wheel
Phase Calculation

Phase Gradients

Swap sidebands ——

—— Phase Maths
Contours

Note: Clicking on a button with CTRL key down will reveal the Settings (if
available).
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gHolo Tutorial
Getting Started

Open the image “qHolo Obj” using the DM command File...Open from the gHolo Manual
folder:

Technical note: this hologram was
acquired on the I2TEM microscope in
Toulouse (Hitachi HF 3300-C) using
a 4K OneView camera (Gatan Inc.)

Hint: right-click on the
image to make the DM
image tools to appear

The hologram is of a metallic nanowire supported by a holey carbon grid which you can just
see on the top left. We call this the Object Hologram, hence the “Obj” in the title, which
indicates the hologram contains the region of interest of the specimen. Later, we will
encounter the Reference Hologram, taken in a field-free region of vacuum.

Use the DM magnifying glass tool < to zoom in to see the narrow holographic fringes. The
fringes do not fill the full field of view, hence the dark regions in the top-right and bottom-left
corners. The fringes are only formed in the overlap region in the centre. We also used the
ingenious two biprism method so that no Fresnel fringes are present in the hologram'.

qHolo...Phase Calculation qHolo

Now let us calculate the phase by clicking on the Extraction Operations
Phase Calculation button or selecting Phase i

Calculation from the qHolo menu. The Power |E|

Spectrum will appear along with a floating menu. Vectorial

& 0

Tools

' K. Harada, A. Tonomura, Y. Togawa, T. Akashi, T. Matsuda, Appl. Phys. Lett. 84, 3229 (2004). Double-
biprism electron interferometry. 10.1063/1.1715155
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Technical note: the power spectrum
is the modulus squared of the Fourier
transform of the image. To avoid
streaking from edge effects, the
image was prefiltered. Any
remaining vertical streaking is due to
the camera (in this case) or the finite
width of the hologram.

Phase Calculation

Project Name [s]g[elleX@]s]]

Mask

ERZE

Display
Binning

RGN Mask Type  Fresnel Filter

V:qHolo Obj  ~

M Apply Correction [H

Notice that the side band (at carrier frequency q) has been automatically detected. The red
circle indicates the cut-off radius of mask. If for some inexplicable reason (this 1s a worked
example!) there is no circle, or the circle is in the wrong place, press Cancel. The Phase
Calculation Window will disappear allowing you place a DM Rectangular ROI tool =+~
around the side band. Press again on Phase Calculation to find the side band position within

the ROI. Just make sure the ROI encloses the sideband spot.

Indeed, if you prefer starting this way, you can do
so by using the Power Spectrum button or qHolo
command. The Power Spectrum will appear and
you can choose the sideband by placing a
Rectangular ROI. Clicking on Phase Calculation |Z|
will display the floating menu with the chosen
sideband. In practice, most people prefer using the - 4
Phase Calculation command directly with
automatic sideband selection.

raction Operations

We will look at the other features later, but for now just click on OK for the phase
calculation, and you should see your first phase image, called “qHolo Obj P”:
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Technical note: we like displaying phase
images using the “Temperature” colour scale
in DM but you can use grey scales if you
really want, just use the DM menu
Object...Image Display...Color. The actual
values in the phase image will not be
changed, only its appearance.

This is what we call a raw object hologram: it has not been corrected for any distortions. For
example, the phase changes rapidly at the edges of the field of view. This is caused by the
projector lenses of our microscope. On a finer scale, you may be able see that there is a
hexagonal contrast from the fibre optics of the camera. We can eliminate these features using
a Reference hologram.

Open the image “qHolo Ref” and use the qHolo...Live Contrast button to examine the
quality of the fringes:

qHolo

Extraction Operations

ONe

6.06 pix / 1.02 nm
1878.02 e-

, Technical note: the Live Contrast ROI
LN S St can be moved and is updated

) automatically. The percentage at the top
gives the fringe contrast, below is given
the fringe spacing in pixels and physical
units if the hologram image is calibrated,
and on the bottom the mean intensity.

The nanowire has been moved awaybbefore taking this hologram so that in principle only the
artefacts from the projector lenses and camera are present. You might notice that there are

-10 -
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some dust particles on the biprism, visible at the edges of the overlap region. They are usually
charged and can create their own electric field. It is important that they are in the same place
for the object and reference holograms, as here. That is why we recommend taking a reference
hologram shortly after the object holograms and to move the specimen away with the stage
controls rather than the image shifts.

With the reference hologram available, click again on the object hologram and launch the
phase calculation as before.

Phase Calculation 0% Phase Calculation X
HOERRETNEE qHolo Obj G ETNEN qHolo Obj H¥nt.: scrolhng menus
Mask Mask mimic the order.of
images on the display,
the frontmost image
2041 gl 2041 Ehy 2
[ Swap 2041 | [ Swap o041 appearing first.
Display Display
Birng 7 Snng i Before lauching Phase
B m o = Calculation click first on
Mask Type  Fresnel Filter REECOE Mask Type  Fresnel Filter the Reference h910gram
— S and then the Object
VeghioloObf = hologram. They will be
W Appy cunsovon [l | 4 Apph Comrection [l Keep same q the first in the list.

] B = l . Fit B =

Choose the Reference hologram from the scrolling menu and click on the Apply Correction
option to tell qHolo to use the reference hologram to correct the phase. On OK, the corrected
phase image should appear:

Technical note: in qHolo, every image

has a “type”, used in the titles and in the
image tags. For example, a phase image
is type P.

The phase image is smoother and the phase variation around the nanowire is clearer. Within
the nanowire, the phase varies rapidly due to the mean-inner potential.

-11 -
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qHolo...Reference Area

The initial value for the carrier frequency q came from the analysis of the power spectrum of
the hologram. It therefore corresponds to the average position of the fringes, irrespective of
the presence of a specimen. It is therefore customary to define a reference area, typically
where we expect the hologram fringes to be uniform and undisturbed.

Once a reference area is defined, qHolo will qHolo

determine the average phase gradient in the

reference area and subtract the corresponding phase Extraction Operations

ramp from the whole image. This is equivalent to 7N
: e T g ]

ensuring that the carrier frequency q corresponds
exactly to that of the chosen reference area of the
hologram. Click on the Reference Area button to
see what happens:

Vectorial

Technical note: the default settings
is a reference area at the centre of the
image, rotated parallel to the
hologram fringes.

These settings can be modified in the
Reference Area dialog that will be
accessed via the Settings->Reference
Area... menu or by pressing CTRL
while clicking on the Reference Area

We might not consider the resulting phase image as an improvement. However, this is

because the default setting for qHolo is to define a reference area in the centre of the image.

In this case, the centre coincides with a region of the nanowire overlapping the vacuum. The
carrier frequency will therefore be set to an average of the fringes in the specimen_and the
vacuum, which does not make much sense. Take hold of the reference AYQA-
region ROI with the DM Selection Tool set to the Arrow and slide the
reference area towards the vacuum. The result should look something like

this:

-12 -
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Technical note: the Reference Area
ROl is active, in the sense that it
reacts when it is moved. It is also an
object in a programming sense. If you
delete a part of it, it will no longer
work. Click on the Reference Area
button and it will reappear at its last
position.

Similarly, if you want to delete it, just
select the whole object by clicking
with the DM Arrow (four green
squares should appear) and press the
Delete button on the keyboard. Again,
clicking on the Reference Area
button will make it reappear.

The mean phase and standard deviation of the phase in the reference area are displayed on the
top left of the reference ROI. Feel free to move the ROI around and you will see the phase
image automatically updated (if not, check that the Automatic Update box is ticked in the
Reference Area dialog. Remember that Settings->Reference

Area... menu or CTRL plus clicking on the Reference Area Define Reference Settings
button will display the settings.) You can also change the size,
shape and orientation of the ROI by gripping and dragging the
different corners.

Automatic Update
Automatic Rotation
Remove Mean Value
Display Mean and Std. Dev.

In the default setting, the mean value of the phase in the
reference area is set to zero. Unclick this option to see what
happens when you move the reference area around. This can
be useful to keep a track of the difference in phase between
difference parts of the image, for example from one to the
other side of the nanowire.

qHolo...Phase Calculation... Keep same

The reason why there is a net phase change from one side of the nanowire to the other is
because there is an electric field present. The nanowire is charged, creating an electric field
around the tip. The phase is directly related to the electric potential, integrated along the path
of the fast electron, in the viewing direction. The phase in the vacuum therefore varies from
place to place: it is not constant. We might legitimately question where the correct reference
area should be? This is where an Option in qHolo...Phase Calculation comes in handy for
quantitative analysis.

You may or may not have noticed this intriguing option when calculating the phase.

-13 -
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Click on the original hologram image and recalculate the phase but this time with the option
Reference...Keep same q. You should see the following result.

Phase Calculation X

H(vud\Eln - qHolo Obj

Mask

Display
Binning P ()

o = O

BEEIENICN Mask Type  Fresnel Filter

J: gHolo Ref b

Apply Correc’ on Keepsameq |

e oo B

We can now see the electric potential emanating from the nanowire, as it should do. What has
happened? With Keep same q, qHolo has applied exactly the same carrier frequency for the
calculation of the phase of the Object and Reference holograms. Subtracting the two phase
images means that we directly see the phase due to the electric field.

It works because in the actual experiment, the Reference hologram was recorded just after the
Object hologram, after having moved the sample away with the stage controls. The optical
conditions have remained the same and the biprism voltage, position and orientation are the
same. This means that the only difference between the two holograms is the electric field. We
can therefore assume that the carrier frequency of the Reference hologram is the undisturbed
carrier frequency for the Object hologram.

qHolo...Phase Calculation...Mask tab — x

. Project Name
The phase calculation also depends on the mask used to collect Mask
the information associated with a given side-band. Have a look picel
at the size options of the Mask tab. The shape of the mask nm
depends on both the Mask Type and the size. Display

Binning Mer O

By default, the Mask type is Cosine. Its value is the cosine of o =
the distance from the carrier frequency, q, normalised in such a Reference Fresnel Filter
way that the mask falls to zero at the chosen cut-off radius, @ Butterworth [

given by the Mask size. The Butterworth mask is a standard O Cosine
mask used in image processing and is flatter up to and till the
cut-off radius and then drops off rapidly as a function of the
power law defined in the box. The Square mask is the most

- 14 -
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basic: it is unity inside a square region defined by the cut-off region and zero beyond. We
have included it for completeness.

Feel free to look at the effect the Mask type has on the resulting phase images. The
Butterworth and Cosine give very similar results whereas the Square mask can introduce
fringing effects at the edges of the phase image. For the rest of the results, we will assume that
the Cosine mask is in use.

The Mask size, or cut-off radius, is the more important feature. By default, the value is set to
Large, equivalent to q/2. The actual radius in pixel! (remember, we are in Fourier space) is
indicated in the box. In our case, the cut-off corresponds to 0.08232 pixel’' equivalent to
1/0.08232 = 12.15 pixels in real space. If the original hologram was calibrated, as for this
example, the equivalent will be given in real-space units, or 2.041 nm in our case. The phase
image will therefore have a spatial resolution of almost exactly 2 nm.

Change the Mask size to Small and the result should look something like this:

Phase Calculation X

M EINE gHolo Obj

M-zl

Sver m

Display
Binning e O

.

Reference NEHQIIN Fresnel Filter

@ Butterworth [ |
O Cosine

@ Square

Hopefully, you can see that the phase image appears smoother and less noisy. Indeed, you can
measure the effect using Define Reference. The standard deviation of the phase in the
reference area is now only 0.045 radians, compared with 0.088 radians for the Large mask.
Indeed, for random variations the standard deviation of the phase is proportional to the
reciprocal mask size. The Small mask has a radius of /4, half the Large mask. The noise is
therefore reduced by a factor of 2.

There was a price to pay of course: the spatial resolution. For the Small mask, the spatial
resolution is only 4 nm, compared with 2 nm for the Large mask. As always, there is a
compromise to be made between precision and spatial resolution.

The Medium mask completes the standard choices, with a mask size of q/3. For some, this is
the maximum size that should be used as the effect of the centre-band is excluded (though see
later). qHolo does not take sides and we allow any size of mask to be used. Just change the
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value directly in the boxes, either pixel! or spatial resolution. The Mask size will then be
indicated as Custom.

qHolo...Contours

It is sometimes useful to add contours to
phase images, either to better understand qHolo
the results or for presentations and papers.

Tools

. Extraction Operations
As usual with qHolo, you can access the -

command using the button on the control EI

window or from the menu. :
Vectorial

Click first on the phase image created = —
using a Small mask and then on the

qHolo...Contour button.

A window will appear with a set of options and settings. The settings include the minimum
and maximum value for the contours. By default, qHolo uses the minimum and maximum
value of the image, but you can choose what you want by directly changing the values in the
boxes. For a phase image, the range of values is usually between —m and =, as here. The
number of contours, N, defines the Step between the contours. For ordinary images, this will
actually mean N+1 contours being presented. We chose this definition to avoid mental
gymnastics for determining the Step size, which is the more important parameter. In our case,
8 means that the Step will be the range of values, 2r, divided by 8 giving /4 for the
separation between contours.

Contours Settings X

Settings

Min Value -3.142
Max Value 3.142
No of contours _

Step 0.7854

Black Contours Thick

| BEIER-N Reset MinMax

Hint: Contours are very sensitive
to noise, so if your contours look
much wavier than this example,
check your Mask size is set to
Small.

Sometimes, the Terraces option can be an attractive alternative. Click on this option to see
the result:
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Contours Settings X

Settings

Min Value -3.142

Max Value 3.142

No of contours _

Step 0.7854

[l Biack Contours [l Thick

o

qHolo...Contours...Coupled Contours

Sometimes it is useful to display the contours on a different image, for example the original
hologram. Examples are given in recent publications.?*

Choose Images

BackGround K: gHolo Obj 65536k

Phase M: gHolo Obj P 4098k

T T

Hint: As usual, first click on the
Phase image, then the original
Hologram to find these image on
top of the scrolling lists.

Note that this function takes into account a difference in pixel size between the
“BackGround” and “Phase” images. Since we have been using Binning 4 for the phase

2 M. Brodovoi, K. Gruel, A. Masseboeuf, L. Chapuis, M. Hytch, F. Lorut, and C. Gatel, Appl. Phys. Lett. 120,
233501 (2022). Mapping electric fields in real nanodevices by operando electron holography.
10.1063/5.0092019

3 L. Zhang, F. Lorut, K. Gruel, M.J. Hjitch, and C. Gatel, Nano Letters 24, 5913-5919 (2024). Measuring
electrical resistivity at the nanoscale in phase-change materials. 10.1021/acs.nanolett.4c01462
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images, the phase image is actually four times smaller in pixel dimensions than the original
hologram image.

As a final remark, qHolo...Contours is not limited to phase images!

qHolo...Cosine

Another traditional way of representing the qHolo

phase maps in holography is to display the

cosine of the phase, which can be accessed Extraction Operations

using the qHolo control window or through |Z| .
N |

the menu qHolo...Cosine...Cosine.

" Vectorial
A Dialog will appear asking for the Factor.
qHolo will calculate the cosine of the phase

multiplied by the factor, a kind of

amplification for the phase variations. With a factor of 8 the following image will be
obtained:

DigitalMicrograph X

Factor ?

BLiAv R s St 5 SN AR,
The factor can be changed by clicking on the UP and DOWN ARROWS of the keyboard. The

result will be updated live. The various options can be assigned via the Settings. Coupled
Cosines can be obtained, similarly but not identically, to the Contours.
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qHolo...Phase Maths

Digital Micrograph provides many ways to add GG
and subtract images, multiply and divide and
other operations (see for example Extraction Operations

DM...Process...Simple Math...). However, |Z|

phase images require some delicacy, notably

concerning the normalisation and the Vectorial
preservation of the processing information EI EI

carried with the image.

Tools

The most common operation is the adding and subtracting of two phase images, which can be
accessed directly via the qHolo Control Window button, or via the menu qHolo...Phase
Maths...Add/Subtract Phase Images. As a simple example, let us carry out the reference
hologram correction manually.

First calculate the phase of the Object hologram, without applying a reference. Now calculate
the phase of the Reference hologram. Click on the qHolo...Add/Subtract Phase button and
enter the two images to be subtracted.

Target Source

o Obj P 4097k

lo Ref P 4097k

You should find the same result as for the qHolo...Phase Calculation with the Reference
hologram applied.

qHolo...Repeat Phase

To illustrate one of the subtleties of phase
calculations we will use the qHolo...Repeat
Phase button. This allows phase images to be Extraction GorErEE

calculated using identical parameters to the .
previous case. IZI

Vectorial

qHolo

Tools

To begin, calculate the phase of the Object
hologram without using a Reference hologram,
as previously. Now, click on the Reference
hologram, to make it the frontmost image, and then press on the qHolo...Repeat Phase
button. You will see the usual dialog window for phase calculations. All of the options and
parameters are exactly like the previous phase calculation. For the moment, do not change any
of the options, and press OK.

G 0
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The phase image of the Reference hologram looks slightly different to that calculated
previously. What has changed? To understand, subtract the phase image of the Reference
hologram from that of the Object hologram using qHolo...Phase Maths...Add/Subtract
Phase images. The resulting phase is identical to the phase of the Object hologram calculated
using the Reference hologram and choosing the option “Keep same q”.

Indeed, qHolo...Repeat Phase does exactly that. The carrier frequency, q, from the previous
calculation is applied directly. This means that the phase of the Reference hologram is
calculated using exactly the same q as the Object hologram. On subtraction we find the
previous result. More generally, if you want to compare the effect of a particular parameter,
say the Mask size or shape, it is best to use this command. You will be sure that none of the
other parameters have been modified between times.

The command is also saves time when many images are to be processed.

qHolo Tags

At this point, you may have been wondering how gHolo keeps a track of all the parameters
and options. In fact, we make ample use of wonderful DM facility of tags. Tags can be global,
see DM...File...Global info..., or attached to an image, see DM...Display...Image info...
All the tags related to gHolo are in folders called qHolo. If you delete or edit them, expect
qHolo to behave strangely. They are extremely important as they provide the history of the
processing. In principle, it is possible to recreate a phase calculation and processing route just
from the information in the tags.

One of the most important tags is the information on the carrier frequency, q, stored as the x
and y reciprocal pixel vector coordinates. For example, many different phase images can be
created from the Object or Reference holograms, as we have seen. Only through the tags can
the differences be identified. For example, if you look at the tags of the previous two phase
images calculated from the Object and Reference holograms, you will see that the carrier
frequencies used were indeed identical.

Here ends the beta version of the qHolo Manual. A tutorial on the
vector functions and the quantification of magnetic and electric
fields will follow. In the meantime, you can find descriptions of all
the functions in the qHolo Quick Reference Guide.
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The gHolo Menu and Windows

The qHolo Menu

qHolo | Custom Help
Power Spectrum
Phase Calculation
Define Reference 4

Repeat Phase

Unwrap/Wrap Phase

Align Two Phase Images...

Cosine 4
Contours 4
Phase Adjustment >
Phase Maths 4
Vectorial 4
qHolo Tools >
Restore Factory Settings
Display gHolo Window

The qHolo Window

The gHolo menu is not the only way to access the commands in gHolo. Open the
gHolo Window with Window...Floating Windows...Technique Manager (GMS
3.x). The window can also be accessed through qHolo...Display qHolo
Window (Before GMS 3.x).

qHolo

Extraction Operations Tools

[N |
Vectorial

Commands can be activated by clicking on the buttons. In fact, this is the way we
usually use gqHolo.
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The commands in the gHolo menu are described below.

Command

Description

Power Spectrum

Calculates and displays the Fourier transform of the
front most hologram (or stack of holograms). The
side-band is then selected in the image of the Fourier
transform (called Power Spectrum) using the DM
rectangular ROI tool.

Button is identical to selecting the menu.

Phase calculation ...

Calculates phase from front most hologram (or stack
of holograms). The Power Spectrum is displayed
with an automatically selected side-band circled in
red. A dialog appears with the choice of options (see
Phase calculation dialog below).

When a Power Spectrum was front most, Phase
Calculation will continue using the Power Spectrum.

Button is identical to selecting the menu.

Define Reference
\&)

==

(see sub menus)

Define Reference submenu of this command defines
the area to be used as reference in the hologram
phase image (see other sub-menus below).

Button is identical to selecting the Define Reference
submenu.

Repeat Phase

@

Repeats phase calculation on the front most
hologram using the previously defined options.
Nevertheless, the Phase Calculation dialog will
appear, allowing options to be changed.

Button is identical to selecting the menu.

Unwrap/Wrap Phase

Unwraps the phase using the Goldstein algorithm, or
wraps the phase between —Pi and +Pi. Unwrap or
wrap will be automatically selected according the
current phase value.

Button is identical to selecting the menu.

Align Two Phase
Images...

Allows two phase images from different Holograms to
be aligned. Corresponding amplitude images will be
used to find alignment conditions.

Cosine Menu for creating a cosine image of the phase
(see sub menus) amplified by a specified factor.

Contours Menu to add contours to the phase image.
(see sub menus)

Phase Adjustment Menu to make adjustments to the calculated phase

(see sub menus)

image, for example to use the same g-vector as
another phase image, or to rotate the phase image.
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Vectorial
(see sub menus)

Menu to calculate derivatives of phase images
(Gradient and Laplacian) including smoothing
options.

gHolo Tools
(see sub menus)

Menu of useful operations, like extracting image
areas, not necessarily restricted to phase images.

Restore Factory
Settings

Resets all defaults and options to the initial values for
gHolo.

Display qHolo Window

Makes the floating qHolo Window appear (before
GMS 3.x).

Phase Extraction

Phase Calculation Command

Phase Calculation Dialog Phase Calculation

o]l \Eln=l Nanowire - holo 1

Mask

Display
Binning

REECNICE Mask Type  Fresnel Filter

W: Nanowire - holo 1 - ref v

Apply Correction Keep same q

me =

The components of the dialog are described below.

Component

Description

Project Name

Name given to the group of images and results. By
default, this is the same as the front most hologram.

Mask Box

Size selection

Large (q/2), Medium (q/3), Small (q/4) and Custom.
Mask size in 1/pixel in Fourier space and nm in real-
space (if calibrated).

Swap

allows the opposite side-band to be chosen. The g-
vector should point towards the reference wave.
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Display Box

Binning

Binning means the phase image will be smaller (in
pixels) than the original hologram, the number of
rows and columns being divided by the binning
factor. This speeds up the calculation and saves
space without loss of information. The binning factor
can be selected from 1,2,3,4,5,6,7,8. Default is 4.

Pand A

When checked, Phase (P) and/or Amplitude (A) will
be displayed.

Mask selection

Radio buttons to select Central or Side band.

Reference Tab

For information about the components of the
Reference tab, see Display Tab below.

Mask Type Tab

For information about the components of the Mask
Type tab, see Mask Type Tab below.

Fresnel Filter Tab

For information about the components of the Fresnel
Filter tab, see Fresnel Filter Tab below.

OK Closes the dialog and starts the image calculation
according to the specified parameters.
Cancel Closes the dialog without executing the command.

Reference Tab

Reference JNER QN ENS I ERIES

W: Nanowire - holo 1 - ref v

Apply Correction Keep same q

mr oo I W

Component

Description

Reference hologram
selection

Pulldown menu to choose a reference hologram from
the list of opened images.

Apply Correction

When checked, the hologram phase will be corrected
using a selected reference hologram image.

Keep same q

When checked, the g-vector will be made identical for
the object and reference holograms.

Fit

When checked, the phase of the reference hologram
is smoothed by performing a polynomial fit before
subtraction. Only the low-frequency artefacts in the
phase, from dust on the biprism for example, are
removed without adding the high-frequency noise
present in the reference hologram. Unfortunately, the
camera may have fixed pattern high-frequency
components that will no longer be removed.

Order

Order of polynomial.
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Show

When checked, polynomial fit image will be displayed
in a separate window.

Mask Type Tab

CEECNE Mask Type ZEEERS]IE

O Butterworth E

@ Cosine
® Square

Component Description
Butterworth Butterworth shape for the mask.
Order Order of Butterworth filter
Cosine Half-cosine mask with hard-cut off given by Mask
Size.
Square Square mask with hard edges. The edge of square
is two times of the Mask Size.
Fresnel Filter Tab RGNV EN QI Fresnel Filter
Medium =
Il Apply Filter
Component Description
Fresnel Filter Strength Strength of Fresnel filter: Weak, Medium, Strong.
Apply Filter When checked, Fresnel filter is applied
Define Reference Submenu Define Reference
Apply Same ROI
Settings
Command Description

Define Reference

If a DM rectangular ROl is present in the phase
image, the command defines this region as the
internal reference area for the hologram fringes. The
corresponding carrier frequency q is recalculated and
the phase image adjusted accordingly (see Settings).
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If no ROl is present, a rectangular ROl is created by
default at the center of the phase image. You may
have to move the ROI, and change its size.

Button is identical to selecting the menu.

Apply Same ROI

The ROI in the Source Image is copied to the Target
Image, and then Define Reference is applied on the
Target Phase Image using the new ROI.

See Apply ROI dialog (see below).

Settings

Opens Settings dialog (see Setting dialog below).

Settings Dialog

Define Reference Settings X

v Automatic Update

v Automatic Rotation

v Remove Mean Value

8 Display Mean and Std. Dev.

B Keep Relative Reference
(For only 3D image)

Component

Description

Automatic Update

Moving the reference area updates the phase images
automatically. If the Mean and Std. Dev. values have
been displayed, they are also automatically updated.

Automatic Rotation

The ROl is rotated automatically parallel to the
hologram fringes.

Remove Mean Value

The average phase in the reference area is
subtracted from the whole phase image.

Display Mean and Std.
Dev.

The Mean and Standard Deviation of the phase in
the reference area is displayed above the ROI.

Keep Relative

This option is relevant only for a stack of holograms.

Reference When checked, Slice 0 is used for the calculation for
all slices. Otherwise, the reference is calculated and
corrected for each slice independently.

Apply Same ROI Dialog Apply Same ROI »

Choose Target and Source images
[ ox |
Component Description

Target Image

Phase image to be adjusted using the same ROI.
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Source Image

Phase image with ROI.

OK

The ROI in the Source Image is copied to the
Target Image. If there is a ROl in the Target Phase
Image, the ROI in the Source Image will replace it.
Then, Define Reference is applied on the Target
Phase Image using the new ROI.

Cancel

Operation is abandoned.
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Phase Operations

Cosine submenu

Cosine

Coupled Cosine
Update

Modify Cosine Image

Set Factor Increment

Component Description

Cosine Creates an image that is equal to the cosine of the
— frontmost phase image multiplied by a user-
uQ definable Factor.

If a Cosine image of the frontmost phase image is
already present, the existing Cosine image will be
updated.

Button is identical to selecting the menu.

Coupled Cosine

Creates a cosine image that is superimposed on a
“Background” image selected via a dialog.

Background
image is Multiplied or Replaced by the Cosine
Image. It does not matter if the phase image has a
different size to the Background image.

NOTE: Replacement option is useful, when the
original hologram is chosen as Background image,
but the phase image has a different size to the
original hologram owing to binning.

Update

Ensures that the Cosine Image is updated using
the current Cosine Factor.

Modify Cosine Image

Allows the user to change the Cosine factor, when
the cosine image is frontmost.

Set Factor Increment

Defines an increment of the Factor for Cosine
image changed by the Arrow keys.

NOTE: When the Cosine image is frontmost, by
using the keyboard Arrow keys, the Cosine image
is automatically updated by increasing/decreasing
the Cosine Factor with this increment.
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Contours submenu

Contours

Coupled Contours
Update

Modify Contour Image

Set Contours Increment

Command

Description

Contours

Creates an image that has contours superimposed
according to the Settings (see Contours Settings
below).

Button is identical to selecting the menu.

Coupled Contours

Creates a Contours image that is superimposed on
a “Background” image selected by the user.

Update

Ensures that the Contours Image is updated using
the current Step size.

Modify Contour Image

Allows the user to change the Contours Settings,
when the contours image is frontmost. (see Set
Contours Settings dialog below).

Set Contours Increment

Defines an increment of the number of contours
changed by the Arrow keys.

NOTE: When the Contour image is front most, by
using the keyboard Arrow keys, the Contour image
is automatically updated by increasing/decreasing
the number of contours with this increment.

Contours Settinqs Dialoq Contours Settings x

Settings

Min Value -3.142

Max Value 3.142

No of contours

Step 0.3696

B Black Contours Thick

B Terraces Reset MinMax

Component Description

Min Value Minimum contour value. The minimum value of the
target image is shown as a default. If the frontmost
is the phase image, this will be -Pi.

Max Value Maximum contour value. The maximum value of

the target image is shown as a default. If the

229




frontmost is the phase image, this will be +Pi.

No of contours

Number of contours to be created (excluding
maximum contour). Automatically adjusts the Step
accordingly if modified.

Step

Step between contours. Automatically adjusts the
number of contours to nearest integer value.

Black Contours

By default, the contours are white. When checked,
the contours are shown in black.

Thick When checked, the width of the contour lines is
made thicker to be more visible.
Terraces When checked, the resulting image has the values

flattened between each contour, creating a
terraced image. Note that on terraced images, no
contours are superimposed.

Reset MinMax

Resets the minimum and maximum values to the
default setting.

OK

Creates the Contour image.

Cancel

Abandons the operation.

Phase Adjustment
submenu

Rotate Phase

Restore Initial q Vector

Apply Same q Vector between 2 Images
Apply Same q Vector for 3D Image

Apply Same Phase Offset between 2images
Apply Same Phase Offset for 3D image
Reset Phase Offset

Command

Description

Rotate Phase

Rotates the phase image whilst correctly dealing
with phase jumps.

Restore Initial g Vector

Resets the current g-vector equal to the initial g-
vector obtained with Phase Calculation command.
Phase image is automatically updated.

Apply Same q Vector
between 2 Images

The g-vector of the Source phase image will be
applied to a Target phase image. The Target
phase image is automatically adjusted and
renormalized. The target image can be 2D or 3D.
When both the Target and Source images are 3D,
the g-vector of the Source image will be applied to
a Target image slice by slice.

Apply Same g Vector for 3D

For phase image stacks, the g-vector of the slice
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Image

specified via a dialog is applied to all the images in
the stack.

Apply Same Phase Offset
between 2 images

The mean phase of the Target image is set to that
of the Source image. When there is a ROI on the
Source image, the mean phase within the same
area of the Target image is set to that within the
ROI on the Source image. The target image can be
2D or 3D.

When both the Target and Source images are 3D,
the mean phase of the Target image is set to that
of the Source image slice by slice.

Apply Same Phase Offset
for 3D Image.

For phase image stacks, the mean phase of the
whole stack is set to that of the slice specified via
a dialog. When there is a rectangular ROl on the
Source image, the mean phase within the same
area of other slices is set to that within the ROI.

Reset Phase Offset

The mean of the whole phase image is set to zero.
When there is a ROl on the phase image, the mean
phase within the rectangular ROl is set to zero.
This command works for both 2D and 3D images.

Phase Maths submenu

Add Constant to Phase
Invert Phase

Add/Subtract Phase Images
Average Stack

Command

Description

Add Constant to Phase

Adds a constant phase in radian or in Pi to the
whole phase image. The constant value will be
specified via a dialog. As might be expected, a
negative value results in subtracting a phase.

Invert Phase

Calculates the negative of the phase
simultaneously inverts the g-vector).

(and

Add/Subtract Phases

Adds/Subtracts two phase images chosen via a
dialog. Add or Subtract can be chosen with the
radio buttons in the dialog. The new phase image
is rewrapped automatically.

Button do the same thing with the menu.

Average Stack

Averages the phase images in a stack, correctly
dealing with the phase jumps.
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Tools and Vectors

Vectorial submenu

Gradient

Generate ColorMap
Change View Type
Display Color Wheel

Command

Description

Gradient

Opens a dialog to calculate different image
gradients (see Gradient Dialog below). The x/y
components will be displayed in different two
windows.

Button is identical to selecting the menu.

Generate ColorMap

Generates a color map to display the gradient in a
single image: the modulus and direction of the
gradient are given by the intensity and by the color,
respectively. Options can be defined by dialog
window (see Generate ColorMap Dialog below).

Button is identical to selecting the menu.

Change View Type Changes display type of gradients among
x/ly components, Modulus/Phase and Complex
selected via a dialog.

Display Color Wheel Creates an image of the Color wheel, useful as
figure legend to go with the ColorMap. The size of
color wheel can be specified.

Gradient Dialoq Gradient Dialog X

Gradient Laplacian
G

.
. -
View Type ]

OXyY @MP @ Complex

Smooth

Resolution = PR
esolution - nm ]
Polynomial Order
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Component

Description

\Y

Calculates the gradient in x (horizontal) and y (vertical)
directions V="V,, =(V,,V,) at the requested spatial
resolution (see Resolution below) and displays them as
separate images.

Calculates the gradient in x and y directions in units of
electric potential, assuming that the phase is purely
electrical in origin (i.e., no magnetic contribution).

E:CEdeZ

—

1 — — -
V= C—V¢>E = fVVdZ = —fExydz
E

Calculates the vector perpendicular to the gradient v
ie, V,=2AV,=(-V,,V,)

Xy

Calculates the perpendicular gradient in x and y directions
in units of magnetic potential, assuming that the phase is
purely magnetic in origin:
oM = %f A,dz
Now:
B=VAA
Therefore:

Vp= j B,y dz =+ (2 AV, ")

The result is the integrated in-plane magnetic field in units
of T.nm.

Voltage

Accelerating voltage, necessary for the calculation of the
in-plane electric field. Greyed out if not necessary.

Resolution

Spatial resolution for the calculation of the gradient. It is
usually necessary to choose a lower spatial resolution
than that of the phase image, because taking gradients
amplifies noise.

Polynomial Order

The gradient is calculated using the Savitzky—Golay
algorithm in 2-dimensions by locally fitting a polynomial to
the phase image (in a square region of dimensions given
by the resolution). The maximum order of the polynomial
is 4.

The gradient is given by the first order of the resulting
polynomial function in the x and y directions.

Smooth

This option shows the phase image smoothed by the
spatial resolution chosen for the gradient calculation.
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Generate ColorMap Dialog

Reset Values

Min Value (%) [
Max Value (%)

Power Factor
Angle Offset (') [0l

Cancel

Component

Description

Reset Values

Resets all the values back to the default values,
namely 0 and 100 %.

Min Value (%)

Outliers below this percentage of the maximum
gradient present in the image will be removed.

Max Value (%)

Outliers above this percentage of the maximum
gradient present in the image will be removed.

Power Factor

Allows a stretching of the intensity values in the
ColorMap (non-linear LUT for the grey scale). By
default, the value is 1 and no stretching is applied.
A value of 0.5 (square root) means the variations
are damped, and a value of 2.0 (square) means the
variations are accentuated.

Angle Offset (°) Sets the zero angle for the color wheel (blue color
direction).

OK Calculates and displays the ColorMap from the
Gradient X and Gradient Y images.

Cancel Cancels the operation.
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qHolo Tools submenu Live Contrast

Extract Area

Create ROI for Extract Area
Copy Same ROI
Define Image Type

Calcul Lambda and CE

Command

Description

Live Contrast

%

Displays the fringe contrast, the fringe spacing (in
pixels and calibrated units) and mean intensity
above a rectangular ROl in the hologram image.
These values are updated as the ROl is moved.

If no ROI is present, a rectangular ROl will be
automatically created. Then, you may have to
move the ROI, and change its size.

Button is identical to selecting the menu.

Extract Area

Creates a new image corresponding to a rotatable
ROI on front most image.

Button is identical to selecting the menu.

Create ROI for Extract Area

Creates a rotatable ROI on front most image from
a Rectangular ROI placed in advance.

Copy Same ROI

Copies an ROI from the “Source” image to a
“Target” image selected via a dialog.

Define Image Type

Allows the image type to be changed, changing the
tag of the image “Type”. Useful for images
calculated outside qHolo.

Calculate Lambda and CE

Calculates the value of the electron wavelength A
and the hologram constant ce from a given
accelerating voltage, and outputs their values in
the DM Output window.

NOTE: c; = % where E is the total energy of the
fast electron.
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